
 

 

1 

 

 

 

 

 

 

 

 

 

 

 

 

User´s Guide 
 

 

 

 

 

 

 

 

 

 

Status 10.04.2024  

Version 5.10.8942.14428 



 

 

2 

Contents 
Sign In ...................................................................................................................................................... 6 

Logout .................................................................................................................................................. 6 

Quit Client............................................................................................................................................ 7 

Main Window .......................................................................................................................................... 8 

Search Line .......................................................................................................................................... 8 

Window Options .................................................................................................................................. 9 

Change Window Size ....................................................................................................................... 9 

Status Indicator ................................................................................................................................. 10 

Online State ................................................................................................................................... 10 

Current Phone Line ........................................................................................................................ 11 

CCD Login ........................................................................................................................................... 11 

Intern ............................................................................................................................................. 12 

Extern ............................................................................................................................................ 12 

Select Processing Group ................................................................................................................ 12 

PC Mode ........................................................................................................................................ 13 

Call Center Options ........................................................................................................................ 13 

Contact Sync ...................................................................................................................................... 13 

Settings/Configuration .......................................................................................................................... 14 

General .............................................................................................................................................. 14 

Language ....................................................................................................................................... 15 

Color Theme .................................................................................................................................. 15 

Status ............................................................................................................................................. 16 

Further Display Options ................................................................................................................. 16 

Active Home Workstation ............................................................................................................. 17 

Client Zoom ................................................................................................................................... 18 

Contacts ............................................................................................................................................. 19 

Extra................................................................................................................................................... 19 

Start c2d5 with ©Windows ........................................................................................................... 19 

Media................................................................................................................................................. 20 

Hotkeys .............................................................................................................................................. 20 

Call, Answer, and Hang up..................................................................................................................... 21 

Click 2 Dial ......................................................................................................................................... 21 

Telephone Links ................................................................................................................................. 21 

Enter in Search Line ........................................................................................................................... 21 



 

 

3 

Call Client Contacts ............................................................................................................................ 22 

Pick Up Calls ...................................................................................................................................... 22 

Calls per Command Prompt Console ................................................................................................. 22 

Hold ................................................................................................................................................... 23 

DTMF Dialing ..................................................................................................................................... 23 

Automatic Callback ............................................................................................................................ 23 

Record Conversations........................................................................................................................ 24 

Connect / 3-Party Conference ........................................................................................................... 24 

Blend out/in Caller Popup ................................................................................................................. 25 

Close and Open Caller Popup ............................................................................................................ 25 

Video Call and Desk Sharing .............................................................................................................. 25 

Options .............................................................................................................................................. 27 

Create ©Outlook Contact ............................................................................................................. 27 

Open ©Outlook / ©IBM Lotus Notes Contact .............................................................................. 27 

Please Call Back E-mail .................................................................................................................. 27 

Tabs ....................................................................................................................................................... 28 

Home ................................................................................................................................................. 28 

Change Profile Picture ................................................................................................................... 29 

Incoming Lines ............................................................................................................................... 30 

PC Mode ........................................................................................................................................ 30 

Home Office – Nomadic ................................................................................................................ 31 

Remote Extension ......................................................................................................................... 32 

Handover Call to a Mobile Device ................................................................................................. 32 

Displayed Phone Number (CLIP) ................................................................................................... 33 

Call Forward................................................................................................................................... 34 

Calendar ........................................................................................................................................ 35 

Contacts ............................................................................................................................................. 36 

Display Options .............................................................................................................................. 36 

Favorites ........................................................................................................................................ 37 

Group ............................................................................................................................................. 37 

Filter............................................................................................................................................... 37 

View ............................................................................................................................................... 38 

Contacts List .................................................................................................................................. 38 

Contact Options ............................................................................................................................. 39 

Contact Details .............................................................................................................................. 40 



 

 

4 

Journal ............................................................................................................................................... 41 

Journal Options ............................................................................................................................. 42 

Filter by Date ................................................................................................................................. 43 

Export Journal ................................................................................................................................ 43 

Delete all Journal Entries ............................................................................................................... 43 

Filter by Call Type .......................................................................................................................... 44 

Contact Options ............................................................................................................................. 45 

Conference ........................................................................................................................................ 46 

Create a New Conference ............................................................................................................. 46 

Invite Participants .......................................................................................................................... 49 

Conference Details ........................................................................................................................ 50 

Add Participants ............................................................................................................................ 50 

Files ................................................................................................................................................ 51 

Participate Conference .................................................................................................................. 52 

Edit Conference ............................................................................................................................. 52 

Delete Conference ......................................................................................................................... 52 

Answering Machine ........................................................................................................................... 53 

Activate Answering Machine ......................................................................................................... 53 

Voice Mails .................................................................................................................................... 54 

Upload/Change/Delete Greetings ................................................................................................. 55 

Team .................................................................................................................................................. 56 

Team Note ..................................................................................................................................... 56 

Undock Team Window .................................................................................................................. 57 

Team Options ................................................................................................................................ 58 

Monitoring ..................................................................................................................................... 58 

Call Forward................................................................................................................................... 59 

Team View ..................................................................................................................................... 60 

Sorting ........................................................................................................................................... 62 

Chat ................................................................................................................................................... 63 

Team Chat ..................................................................................................................................... 64 

Undock Chat Window .................................................................................................................... 65 

Outbound .......................................................................................................................................... 66 

Outbound List ................................................................................................................................ 66 

Automatic Outbound Call .............................................................................................................. 66 

Edit an Outbound Call ................................................................................................................... 67 



 

 

5 

CCD Dashboards ................................................................................................................................ 68 

Undock CCD Dashboards Window ................................................................................................ 68 

Element Pilot ................................................................................................................................. 69 

Service Light .................................................................................................................................. 69 

Element Pilot (Daily Stats) ............................................................................................................. 70 

Element Queue .............................................................................................................................. 70 

Element Processing Group (Agents) .............................................................................................. 71 

Tab Change after Time .................................................................................................................. 71 

Adjust Dashboard View ................................................................................................................. 72 

Internet Phonebook .......................................................................................................................... 73 

Browser ............................................................................................................................................. 73 

Taskbar Menu ........................................................................................................................................ 74 

Taskbar Info ....................................................................................................................................... 74 

Busylight ................................................................................................................................................ 75 

Door Camera ......................................................................................................................................... 75 

 

Following short form is used: c2d5 = click2dial5 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

6 

Sign In 
Starting the client there are two types to sign in. The options which are available depend on the 

configuration of the c2d5 server. 

o ©Windows Credentials  

The signed in ©Windows user will be signed in at c2d5 automatically. 

 

o Manual Registration 

Regardless of the ©Windows user who is logged in, the user can sign in with the own login 

data. 

 

 

 

 

 

 

 

The login data can be saved. 

 

Logout 
Logged in users have the option “Logout” in the profile in the Home Tab. 

 

 

 

 

 

 

A security request follows. If the logout is not confirmed within 10s, the user remains logged in. 

 

 

 

 

 

 

Save Login Data 

Logout 

from c2d5 
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Logging out is also available by right-clicking on the c2d5 Icon in the taskbar:  

 

 

 

 

 

 

 

A security request follows. If the logout is not confirmed within 10s, the user remains logged in. 

 

 

Quit Client  
To quit the client, click on the cross        in the upper right corner of the Main Window. 

A security request follows. If c2d5 should not be closed, a confirmation of “No” must be given within 

10s, otherwise the client will be closed. 

 

 

 

 

 

 

Quitting the client is also available by right-clicking on the c2d5 Icon in the taskbar:  

 

 

 

 

 

 

 

No security request follows. The client is closed immediately. 

Logout from c2d5 

Quit c2d5  
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Main Window 
Overview 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Search Line 
The search line is always available regardless of the selected tab. 

If a phone number is entered in the search line, it can be directly called by pressing the enter key. 

In the settings there is the possibility to empty the search line after one minute. See the chapter 

Settings/Configuration -> Further Display Options. 

When entering names, company, and phone numbers, depending on the selected tab these are 

searched in the Contacts Tab or in the Journal Tab and displayed if available. Different criteria must 

be separated with a space.  

Example: 

 

 

If you had searched in the Journal, you could search for the entry directly in the Contacts by pressing 

the enter key. 

 

 

Sync Contacts 

Search Line 

Status  

Display `logged on´ 

for Call Center 

Settings 

Quit c2d5  

Tabs 

Window Options 
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Window Options 

Overview 
 

 

 

 

 

 

 

        Dock Left – The window is displayed on the left side of the screen. 

 

        Dock Right – The window is displayed on the right side of the screen. 

 

        No Dock – The window can be placed anywhere on the screen. 

 

        Minimize – The window will be hidden.  

With a click on the c2d5 Icon          in the taskbar, it is displayed again.  

 

        Always on Top – The window is kept permanently in the foreground and is always displayed.  

 

        Exit – The window is closed and c2d5 is quitted. 

 

         Configuration – Opens the client settings menu. See chapter Settings/Configuration. 

 

 

Change Window Size 
To resize the client window, you first must undock the window from the desktop.        Resize the 

undocked window by dragging the edge of the window with the mouse. When the window is docked 

again, it keeps the changed size. 

 

 

 

Dock onto left 

side of desktop 

Undock from desktop 

Minimize/Hide 

Quit c2d5 

Pin to Top 

Dock onto right 

side of desktop 
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(Only to see at call center) 

(Only to see at call center) 

green = active  

red = offline 

(Only to see at call center) 

Status Indicator 

Overview 
 

 

 

 

 

 

Online State 
The Online State can be changed to “Online”, “Be right back” or “Offline”. If the user is inactive for a 

certain period of time, the status automatically changes to inactive. The time after which this 

happens can be configured on the c2d5 server. The next time the user is active, “Online” will be 

displayed again. 

 

 

 

 

The color of the Online State is displayed in the Team Tab and written in the Team Note. 

   

 

 

 

  

 

 

 

 

 

 

 

 

WrapUp 

Withdrawn 

Agent login/Logoff 

Online State 

Current phone line displayed 

yellow = inactive  

 

 

Selection Menu 

Team Note 
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Current Phone Line 
The current used phone line is displayed on top. If the user has several phone lines, it´s status can be 

seen here. Active lines can be chosen. 

                                                      

 

 

      active line is free                 active line is busy                   out of order 

 

CCD Login 
Clicking on the CCD Login Icon         in the Main Window opens a window to choose different logging 

on options. Choose one and click the Sign In button to log in agent at call center. 

 

 

 

 

 

 

 

 

 

 

            Use your office phone to make calls. 

                          Use an external phone number to login. Calls will be received on this. 

             Use the PC and a head set to make calls without an extra device. 

 

After signing in the logging information is shown in the top of the client. Example: 

 

 

 

 

 

Show phone lines 

Selection Menu 

Processing Group 

CCD Login 

Sign In 

Phone Number Logged On 

Active Line 

Call Center Options 
Processing Group Signed in 



 

 

12 

Intern 
Enter your office phone number to sign in.  

 

 

 

 

 

 

 

 

 

Extern 
To sign in with an external number, type a 0 in front of the used number: 

 

 

 

 

 

 

 

Incoming calls can be accepted on the registered external device. If calls are made, this device rings. 

Accept the call to start the conversation on this device.  

 

Select Processing Group 
Agents with the right to choose the processing group they sign in, have a drop-down menu to select 

from. If an Agent wants to sign in without being assigned to a processing group, they choose:  

 

 

 

 

 

 

 

Selection Menu 

Processing Group 

Enter External 

Number 

Enter Office 

Phone Number 

Selection Menu 

Processing Group 

Sign 

In 

Sign 

In 

Selection Menu 

Processing Group 
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PC Mode 
If you signed in your call center agent in PC Mode, a yellow bar is shown in the top of the client.  

 

 

 

 

 

 

 

 

To activate/deactivate muting of the microphone or speaker, click on the corresponding icon:      

                         activate muting:        /          deactivate muting:         / 

 

To quit PC Mode, log off the agent by clicking on this icon:  

 

Call Center Options 
Click on the icons to do following actions: 

 

        CCD Login - Agent will be signed in at call center. 

 

        CCD Logoff - Agent will be signed off at call center.  

 

        Withdrawn – Agent is not available for CCD. Team gets message that he is taking a break. 

 

       WrapUp - Agent is not available for CCD. Team gets message that he is doing after call work. 

 

 

Contact Sync 
 

 

                                      

 

To start Contact Sync, click on this icon in the bottom of the window: 

Date and state of Last Sync Contact Sync 

Call Center Options 

Active Line Processing Group Signed in 

Mute / Unmute 
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Settings/Configuration 
Clicking on the gear        in the Main Window will open the Settings Menu. 

 

 

 

Right-clicking on the c2d5 Icon        you can also find the Settings Menu.  

 

 

 

 

 

 

 

General 

Overview 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Configuration 

General Tab 

 Configuration 
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Language  
Following languages are available:  

 

The client must be restarted to apply the new setting. 

 

Color Theme 
To change the window colors following themes are available: 

 

Examples: 

                                                                   

                                                                           

 

 

 

 

 

 

 

 

 

 

Selection Menu 

Selection Menu 
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Status 
Here you can choose which online state is displayed when starting c2d5. 

 

 

 

 

 

Further Display Options 
In the General Tab following display settings can be made and popups can be activated: 

 

If you set this, the client icon is shown in the ©Windows taskbar when it´s active: 

   

  

 

 

Program hints of the client can be set here. 

Example of info message:  

 

 

 

 

 

 

 

 

If you set this, a little popup window shows up on the upper left of your screen when favorites 

change their online state. 

Examples:  

             

 

 

Selection Menu 
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If this is set, a popup appears when you missed calls. Otherwise, these are only in the Journal Tab.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If the client should switch to the Journal Tab automatically when there are missed calls, this has to 

be set.  

 

  

If the client should switch to the Outbound Tab automatically when there are missed call center 

calls, this must be set.  

 

 

If this is set, the search input will be deleted after one minute. 

 

Active Home Workstation  
 

If this is set, the home workstation will not be deactivated when exiting the client. The nomadic 

connection can still be used after quitting the client. This does not work for call center agents.  

Click to 

start call 

Create ©Outlook 

contact 

Callback mail 

Delete Journal entry 

If this is not set, the entry in the Journal Tab stays 

as “Unanswered incoming (New)” in the list 

Close window 

Apply to Favorites 
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Client Zoom 

 

The client zoom can be used to adjust the font and icon size. The further to the right the controller is 

pulled, the larger the display is. 

 

Examples: 
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Contacts 

Overview 
For each available contact database, it has an own tab. Which contact databases are available, is 

configured on the c2d5 server. By setting checkmarks the directories are chosen. Chosen directories 

are available in the Contacts Tab of the client. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Possible client contact databases are: ©Outlook, ©IBM Lotus Notes, and ©DasTelefonbuch. 

 

Extra 

Start c2d5 with ©Windows 
If the client should start with ©Windows, you can set it here. 

 

 

 

 

 

 

 

 

Contacts Tab 

Tabs contact databases 

Extra Tab 
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Play test tone 

Media 
Here you can choose and test media devices and ringtones for the PC-Mode and system tones. 

Available media devices depend on your system.  

Overview 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hotkeys 
The right to choose or adjust hotkeys must be configured on the c2d5 server, otherwise this window 

is greyed out.  

To define a key combination, click in the input box and then press the key combination you want to 

use. In this example LeftCtrl+2 to hang up. Make sure that the hotkey is not used by other systems. 

 

 

 

 

 

 

 

 

Media Tab 
Device selection 

Hotkeys Tab 

Input box 

Tone selection 
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Call, Answer, and Hang up 
Calls can be done as usual by dialing on your desk phone or softphone. 

At outgoing and incoming calls, a popup appears: 

 

 

 

 

 

 

 

 

To accept or hang up a call, click on the Telephone Receiver Icon: 

           answer                            hang up 

Or use the configured hotkey. See chapter Settings/Configuration -> Hotkeys. 

 

Click 2 Dial 
Calling is from any application possible that allows copying a marked text to the clipboard. Mark the 

telephone number that you want to call and press the configured hotkey. See also chapter 

Settings/Configuration -> Hotkeys 

➔ For example: left ctrl+1  

The formatting of the number is recognized automatically by c2d5. 

 

Telephone Links 
Telephone links on the internet can be clicked to start calls with the client. 

 

 

Enter in Search Line 
In the Search Line entered telephone numbers can be called by pressing the enter button.  

 

 

 

Blend out 

popup 

Options 

Answer/ 

hang up 

DTMF Dialing 
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Call Client Contacts 
To make calls you can also click on phone numbers in the c2d5 window or double click on team 

members in the Team Tab. 

Example Contacts: 

 

 

 

 

Example Journal: 

 

 

 

 

 

 

Example Team:  

 

 

 

 

 

 

 

Pick Up Calls 
Calls can be picked up from team members by double clicking on the called person. 

 

Calls per Command Prompt Console 
To make calls with console insert the command -dial + telephone number: 

Example:  

 

 

Call by 

click 

Call by 

click 

Double click team 

member to call 
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Hold 
To put conversations on hold, press the Hold Icon in the caller popup: 

 

DTMF Dialing 
To send key tones use DTMF Dialing by clicking on the Note Icon:   

A keyboard appears. Here you can dial per mouse click: 

 

 

 

 

 

 

 

 

 

 

 

 

Automatic Callback 
Permission is required for this function. If the called c2d5 user is busy or doesn´t answer, you can 

click this icon             in the Caller Popup to set an automatic callback. If the called user hangs up, your 

phone will ring, and you can start a call by answering the call. Unreached user´s phones will flash to 

indicate a callback request. 

 

 

 

 

 

 

 

 

 

DTMF Dialing 

Automatic Callback 
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Record Conversations 
If the user has an answering machine and the permission, conversations can be recorded. Click on 

the Record Icon           in the Caller Popup to record them. The recordings will be on the own 

answering machine as messages from the user himself. See also chapter Answering Machine. 

 

 

 

 

 

 

 

 

Connect / 3-Party Conference 
At another conversation another caller popup appears. Now it is possible to transfer the call or start  

a 3-Party Conference. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Record Conversation 

First Conversation 

Second Conversation 

Transfer  Start Conference 



 

 

25 

Blend out/in Caller Popup 
Clicking the arrow,      the caller popup is blends out. A bar remains, by clicking on the arrow      it is 

blended in again. 

 

Close and Open Caller Popup 
Clicking on the cross        the caller popup closes. 

To open it again, click on the c2d5 Icon in the taskbar in the right lower corner: 

 

 

 

Video Call and Desk Sharing 
At calls with other c2d5 users there is Video Call or Desk Sharing as an additional function. For video 

calls an integrated or connected camera is needed. To start a video call, click on this icon              in 

the Caller Popup. 

 

 

 

 

 

 

 

 

 

 

The called person gets an invite for the video call. This must be accepted in the next 10s or the video 

call will be rejected.: 

 

 

 

 

 

 

Start Videocall 
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If the called user rejects the video call you receive a message. 

 

 

 

 

 

 

If the video call is accepted, a window will open to choose by clicking on the picture if the camera or 

the desktop is shared. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The marked window has a green outline. This content is seen by the other person. 

If you don´t want an image to be transmitted, click on “No Video”. 

To set the window on full screen click on      . To return to normal screen size click on       .  

 

Switch to Full Screen 

Own image 

Own 

desktop 

Picture of 

called user 
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Options 

Create ©Outlook Contact   
Clicking on this icon,           a window to create an ©Outlook Contact opens. 

In first choose where the contact is saved: 

 

 

 

 

 

 

 

When clicking OK ©Outlook opens. The contact can be edited before saving. 

 

Open ©Outlook / ©IBM Lotus Notes Contact 
If the contact is already saved, you get the opportunity to open the business card of the contact by 

clicking on the corresponding icons:  

        Open ©Outlook Business Card                         Open ©IBM Lotus Notes Business Card 

 

 

Please Call Back E-mail 
Clicking on this icon         a new email with the existing data of the caller is created. The format for 

this can be configured on the c2d5 server. To edit and send the e-mail, click in the taskbar on it to 

open it. 

Example: 

  

 

 

 

 

 

 

 

Auswahlmenü 
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Tabs 

Home 

Overview 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Profile 
In the Home Tab you can see the profile information. 

Overview 
 

 

 

 

 

 

 

Home Tab 

Externally 

displayed number         

Rufnummer 
Call forward 

Appointments 

Profile 

Incoming lines 

Profile Picture 

Delete Photo 

Home Tab 

Take Photo 

Search Photo 
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Change Profile Picture  
In the Home Tab the profile picture can be taken, changed, or deleted. 

        Take photo – Take a photo for the profile picture.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

       Search photo - Use an existing photo on your PC as your profile picture. 

 

 

 

 

 

 

 

 

 

 

        Delete photo – Delete profile picture. 

 Select camera 

Take picture 

OK           

use picture 

                      Cancel 

take a new photo 

Edit cutout 

Use cutout 
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Incoming Lines 
In the Home Tab you can choose with a click on which line you want to accept calls. The incoming 

lines, which are available, are configured on the c2d5 server. 

Example:  

 

 

 

                           

      The standard used line is the office line. 

 

PC Mode 
                                     In PC Mode you can make calls with c2d5 without a telephone set. The client 

acts like a softphone in this case. To choose this line, click on it in the Home Tab.  You can see a 

yellow bar in the top of the client, if the PC Mode is active. This PC Mode cannot be used as a call 

center agent. To use PC Mode as a call center agent, see chapter Main Window-> CCD Login-> PC 

Mode.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To activate/deactivate muting of the microphone or speaker, click on the corresponding icon:      

                         activate muting:        /          deactivate muting:         / 

To quit the PC Mode click on the cross        or choose an other incoming line.   

PC Mode Active 

 

Activate 

/Deactivate 

PC Mode 

Deactivate 

PC Mode  

Mute / Unmute 

Home Tab 



 

 

31 

Home Office – Nomadic 
                                                          When using this line, the first time, a telephone number must be 

inserted to take calls at. For this click on the Gear Icon,         enter a phone number and press the 

enter key.  

 

 

 

 

 

 

If there is already a telephone number registered, the Home Office Line can be activated directly by 

clicking on it. 

If the Nomadic Connection is active, the used telephone number is displayed in a bar in the Main 

Window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To deactivate the Nomadic Connection, click on the cross          or choose an other incoming line to 

accept calls at.  

By clicking on the Gear Icon,        the phone number for the Nomadic Connection can be changed.    

To use this line the user must not be logged in at a call center. To use Nomadic as a call center agent, 

see chapter Main Window-> CCD Login-> Extern 

Insert Telephone Number 

Enter telephone number here 

Home Office 

active 

De-/activate 

Home Office  

Deactivate 

Home Office Home Tab 



 

 

32 

Remote Extension 
The Remote Extension is used to make calls on a mobile device.  

                                            If the user has a remote extension installed, he can switch it on and off in 

the Home Tab underneath Incoming Lines. This is not able for call center. To activate/deactivate click 

on „Mobile“.    

To enter the number of the used mobile device, click on the Gear Icon.   

 

 

 

 

If the Remote Extension is active, incoming calls can be accepted on the deposited mobile phone.  

If outgoing calls are made, the deposited mobile phone rings, accept this call to start the call on this 

device. 

 

Handover Call to a Mobile Device 
With an installed remote extension, it is possible to handover calls to a mobile device without 

interruption. To do this, the user must not be logged on to the call center.  

In the Caller Popup you have the option to handover to a mobile device while being in a 

conversation.  

Click on this icon:               and choose the remote extension line. 

 

 

 

 

 

 

 

 

 

The deposited mobile phone rings now, accept the call here, to carry on the conversation on this 

device. 

Insert Mobile Number 

Remote Extension 

active 

Handover to Other 

Device 

Choose Remote Extension Line 
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Displayed Phone Number (CLIP) 
Depending on the configuration on the c2d5 server, users have the option to change the extern 

displayed phone number on the Home Tab. The rights to do this also are set on the c2d5 server. 

Different profiles can be created.     

 

 

 

 

 

 

 

 

 

 

 

Following options can be available: 

 

                                     No phone number is transmitted. 

 

                                                           The number configured in the phone system is transmitted.  

Standard is the own phone number. 

 

                                               Example for a phone number configured on the c2d5 server.   

 

 

 

 

 

 

 

 

 

Selection Menu 
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Call Forward 
A call forward can be set in the Home Tab. To set a call forwarding, the user must not be logged in as 

a call center agent. Following call forward options are available:  

 

 

 

 

 

 

 

 

                            Calls will not be forwarded. 

 

                                       Calls will be forwarded immediately. 

 

                               Calls will be forwarded when the line is busy. 

 

                                     Calls will be forwarded after a certain time. The time is configured on the 

telephone system. 

 

                                      Calls will be forwarded after a certain time and when the line is busy.            

                       

 

 

 

 

 

If the call forward is active, you can see it in the red line on the top of the Main Window. To 

deactivate it, click on the cross          or set the call forward to “no forward” in the Home Tab. 

 

 

 

 

Selection Menu 

Enter Search Term or Number 

Select where the calls are forwarded to 

Call Forward 

active 

Deactivate 

Call Forward 
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Appointment 

Entry 

Calendar 
In the Calendar you can see the ©Outlook appointments. This function is configured on the c2d5 

server. Depending on the setting the appointments of the next 3, 5, or 7 days are displayed.                                                                      

 

 

 

 

 

 

The current or next appointment is also displayed in the Team Tab and for team members visible.  

Example: 

 

 

 

 

 

If the mouse cursor is moved over the Calendar Icon       all appointments of the next 3, 5, or 7 days, 

depending on the configuration on the c2d5 server, are displayed. 

Example: 

 

 

 

 

 

 

 

 

 

 

 

Current 

Appointment (red) 

Show 

Appointments 
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View 

Display Options 

Contacts Tab 

Direct Selection 

First Sign 

Account 

Displayed/Total 

Contacts List 

Contacts 

Overview 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

Display Options 

Overview 
 

 

 

 

 

Favorites 

Group 

Filter 
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Favorites 
Change the selection with clicking on the star: 

         Not selected 

All contacts are displayed. 

         selected 

Only favorites are displayed. 

 

 

Group 
Contacts with the same name, which are found in several address books, can be grouped to one 

entry. By clicking on the Grouping Icon         this is activated/deactivated.      

Example: 

                             not grouped                                                                                 grouped 

 

 

 

 

 

 

 

 

Filter 
By clicking on the Filter Icon,        a menu opens to choose the address books from which the contacts 

should be displayed.  

   

 

 

 

When the filter is active, the icon looks like this:  

These databases are supported: ©Outlook, ODBC, ©Das Telefonbuch, LDAP, ©IBM Lotus Notes, 

Open Touch, OXE Enterprise 

Selected with 

check marks 
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State of line 

View 
Die representation of the view of the Contacts Tab can be detailed or compact.  

 

 

 

Example:  

 

 

 

 

 

 

 

 

 

 

 

 

Contacts List 

Overview 
 

 

 

 

 

 

 

 

 

 

Selection menu 

State of team 

members 

Contact 

picture 

Name   

Company 

Contact data 

Contact options 

Contact info 
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Contact Data 
Contacts can have following data: 

       Telephone number 

       E-Mail address 

       Web address 

       Address 

By clicking on the telephone number, the contact is called immediately. 

By clicking on the e-mail address a new email to the contact is opened in the e-mail program. 

By clicking on the web address the internet page of the contact will be opened in the browser.  

By clicking on the address of the contact ©Google Maps will be opened in the browser and a route to 

the contact can be planned. The Address Icon can be configured on the c2d5 server.                                                                                     

 

Contact Info 
Contact entries can have further information as text. These can be copied in the clipboard by clicking 

on the text. For example: „Maintenance: Mo – Fr 8.00AM – 17.00PM“ or „Customer number 1234“ 

 

State of the Line 
       Active line free                 Active line busy               Out of order 

        Call Center Agent free           Call Center Agent busy              CC Agent out of order 

 

Picture of Contact 
At team members the profile picture is displayed. At other contacts the pictures can be stored in the 

database, for example company logos. 

 

Contact Options 
By clicking on the icon: 

        /        Remove from favorites / add to favorites 

         Open ©Lotus Notes business card 

         Open ©Outlook contact 

          Make an ©Outlook contact 

          Open contact details 
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Contact Details 
The Contact Details show further information: 

 

 

 

 

 

 

 

 

 

 

 

 

Calling List/Journal 
If calls were made with this contact, a Journal Tab is available in the contact details. Here you can see 

a list with calls made with this contact. Company intern missed calls, while the user was busy, are not 

registered.  

 

 

 

 

 

 

 

 

 

 

The different types of calls are displayed like this: 

        answered outgoing                   unanswered outgoing 

        answered incoming                  unanswered incoming                  conference 

Database from 

which the 

contact entry 

is from 

Info Tab 

Journal Tab 

 Type of Call 

Options 

Shows State 

of the Line 
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Telephone 

Number 

Options 
See chapter Journal-> Contact Options 

 

Calendar 
At team members the Calendar Tab is available. Here you can see the @Outlook appointments of 

the next 3, 5, or 7 days of the contact. Depending on the configuration of the c2d5 server.                             

 

 

 

 

 

Journal 
In this list made calls, answered calls, and missed calls are displayed. Intern of the company missed 

calls are not displayed. 

Overview 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Calendar Tab 

Journal Tab 

List Options 

Contact 

Options 

Amount of Calls 

Displayed / Total 

 Call Info 
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Filter by call type 

Amount of 

grouped calls 

Telephone Number 
Telephone numbers in the Journal can be called directly by clicking on them. To copy the number, 

click with the right mouse button on them. 

 

Call Info  
Call info like call type, date, time, and durance of the call are displayed here. The different call types 

are displayed like this: 

 

 

 

 

Journal Options 
 

 

 

 

 

 

Group  
Clicking on the Grouping Icon        calls with the same contact are grouped and displayed as one 

entry. The info of the last call is shown, and the number of calls is displayed after the name. 

Example: 

 

 

                                                                                                      

 

 

 

 

 

 

 

 

Group 

Filter by date 

Export journal Delete all entries 
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Filter by Date 
By clicking on the Calendar Icon,         the calendar will open to filter the journal by date. Choose the 

date which calls you want to be displayed. To deactivate the filter, click on the Filters Off Button. 

 

 

 

 

 

 

 

 

If this filter is active, the icon looks like this:  

 

Export Journal 
By clicking on this icon,         the journal can be exported as a .txt-file. 

Example:     

 

 

 

 

 

Delete all Journal Entries 
By clicking on the Trashcan Icon,       the complete calling list will be deleted. A security request 

follows: 

 

 

 

 

 

 

 

No Filter 
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Filter by Call Type 
The Journal can be filtered by call type. Following call types can be selected:  

 

 

 

 

 

 

 

                                                            

Unanswered incoming new calls that haven´t been read yet (new) are marked red in the Journal. 

Clicking on the green checkmark        marks them as read.     

 

 

 

 

 

 

 

 

The amount of new missed calls is displayed in the Journal Tab Icon:  

 

 

 

 

 

 

 

 

 

 

Selection Menu 

Mark all calls as read 

New Call 

(red) 
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Contact Options 
By clicking on these icons, following options are selected: 

      Show all telephone numbers, these can be called by click                                                                     

(team members       / call center     ) 

                  Remove from favorites / add to favorites 

        Chat – only available for team members 

        Write e-Mail 

        Make ©Outlook contact 

        Open ©Outlook contact 

        Open ©Lotus Notes business card 

        Show websites. By clicking on the link, they will be opened in your browser. 

        Make a please call back e-mail. For more see chapter Call, Accept, and Hang up -> Options -> 

Please Call Back E-mail  

        Delete single journal entry 

        Open ©Google Maps in browser, to plan a route to the address of the contact.                                      
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Conference 

Overview 
 

 

 

 

 

 
 

 

Create a New Conference 
Clicking on this icon        opens a window to create a new conference. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Enter the conference name in the subject input box: 

 

 

 

 

Conference tab 

Create a new 

conference 

Delete all expired conferences 

Name of the conference 

Type selection menu 

Save 

Cancel 

Profile selection menu 

Date/Time 

selection 

Password 

settings 
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Choose the conference type: 

 

 

 

 

                                         Is taking place once   

   

 

                                        Daily, weekly, or monthly repeating 

 

 

 

 

                                              This conference can stay up to six months. It is allowed to call in any time 

you wish with the same login data. 

 

 

 

Select duration of conference:   

(Except for “Reservationless Conference”) 

 

Choose conference type:       

The right to choose different profile types is configured on the c2d5 server. 

 

 

 

 

 

 

 

 

Type selection menu 

Selection menu profile 
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                  The profile corresponds to a standard meeting. The main characteristics of such profile are: 

- Callers names are recorded and announced when joining the conference. 

- No limitations on conversation between members (except the ones specific to leader / participant 

role). 

- All members can control their audio (mute / unmute ...). 

- All members can join on their preferred way (audio only, web only, audio and web). 

 

                  This profile is designed for a webinar session. The main characteristics of such profile are: 

- Only leaders can interact with participants. Participants can not see each other. 

- Participants join the audio conference as muted and can not change it. 

- The audio conference will end as soon as the last leader leaves. 

- Callers names are not recorded, nor announced (not even join tones). 

 

                     This profile corresponds to an audio only conference session. 

 

                   This profile is designed for a training session. The main characteristics of such profile are: 

- The presentation is led by the owner (the 'trainer'). 

- Trainees join the audio conference as muted, but they can not change it. 

- The audio conference will end as soon as the last leader leaves. 

- Callers names are recorded and announced (no join tones). 

 

Set a password 

                              No password needed to participate conference 

                                          A password is set from click2dial5  

 

 

                                Set an own password for the conference 

 

 

 

Save the conference by clicking on the green checkmark:  
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Created conferences appear in the list: 

 

 

 

 

 

 

 

 

Invite Participants 
To invite participants by e-mail, click on the envelope         or create an ©Outlook appointment by 

clicking on the clock. 

The invitations can have these types:  

 

 

 

 

 

Audio – telephone call conference 

Web – participation by website 

The invited participants receive via e-mail or ©Outlook appointment the access data. These are 

configured on the c2d5 server.  

Example: 

 

 

 

 

 

 

 

  

Conference options 
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Conference Details 
To open the Conference Details, click on this icon: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Add Participants 
In the Users Tab           of the Conference Details participants can be added to the conference per 

drag and drop from the Contacts List. Also, you can select a participant to be the conference leader. 

You can search in the Contacts List for names. To delete participants, click on the Trashcan Icon.  

 

 

 

 

 

 

 

 

 

 

Info Tab 

 

Select to be 

conference leader 

Delete 

participant 
Name 

Search 

Users Tab 

Name of the conference 

Name of the conference 
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Files 
At the Files Tab         of the Conference Details files can be added to conferences by drag and drop. 

                                 

 

 

 

 

 

 

 

A popup appears to choose how the files are provided to the conference.  

 

 

 

 

 

 

 

Uploaded files appear in the list. 

 

 

 

 

 

 

 

 

 

 

 

 

Delete file 

Download file 

Open file 

Files Tab 
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Participate Conference 
To participate click on the icons of the conference in the list of the c2d5 Conference Tab: 

         Participate by phone                     start web conference 

 

Or follow the link in the e-mail invitation to start the web conference. To participate by phone, call 

the number saying in the invitation. 

The conference leader has its own access code. You can see it in the Conference Details.   

Example: 

 

 

Edit Conference 
To change conferences afterwards, click on the Pencil Icon:  

 

Delete Conference 
To delete all expired conferences, click on the Trashcan Icon in the Conference Tab:  

 

 

 

 

A security request follows: 

 

 

 

 

 

 

To delete single conferences, click on the Trashcan Icon         of the single conference in the list. A 

security request follows.  

 

 

 

 

Delete all expired conferences 

Delete Conference 
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Answering Machine 
If the user has an answering machine, it can be handled with this tab. 

Overview 
 

 

 

 

 

 

 

 

 

Activate Answering Machine 
To activate the answering machine a call forward to the answering machine must be set.  Click on the 

Call Forward Icon        and choose when the call forward is active.  

 

 

 

 

 

 

 

Otherwise set a call forward in the Home Tab to the number of the answering machine. See chapter 

Tabs-> Home-> Call Forward.  

If a call forward to the answering machine is active, you can see a bar in the Main Window. 

 

 

 

 

 

 

Upload Greeting 
Delete Voice Mails 

Forward calls to 

Answering Machine 
Delete Greeting 

Active 

Greeting 

Greetings Selection Menu 

Answering Machine Tab 

Info 

Mailbox 

is Active 
Quit 

Forwarding 

Call Mailbox 
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Voice Mails 
The amount of new voice mails is shown in the Answering Machine Icon of the tab.                 

Recorded calls are in the list as a voice mail from the user itself.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Voice Mail Options 
Following possibilities are started by clicking on the corresponding icons: 

       A call to the answering machine follows to play the message. 

       Pause playing message. 

       Stop playing message. 

While playing a message it can be fast forwarded or rewinded by holding and drawing the slider with 

the mouse.                    

 

Further Options 
By clicking on the corresponding icons: 

        /        Add/remove from favorites                       Open ©Lotus Notes business card 

         Open ©Outlook business card                                            Create an ©Outlook contact 

       Delete Voice Mail                         Chat (only possible with c2d5 user) 

     /        Call                                         Write e-mail  

New 

message 

Further options 

Voice Mail options 
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Upload/Change/Delete Greetings 
If there is no greeting uploaded the caller hears the standard greeting from the telephone system. 

Then the client shows you that the Default Greeting is active.   

    

 

 

As standard the answering machine asks you to record your name when it is installed. If this is done 

the active greeting is the Name Greeting.  

 

 

 

 

On the answering machine you can record several voicemail greetings. Alternative Greeting 1+2, 

Extended Absence Greeting, Personal Greeting and Personal Greeting for Internal can be selected. 

If an announcement is stored behind a greeting, the font of it is bold. To choose a greeting click on it 

and activate it by clicking the green checkmark.           Default can only be chosen if there are no other 

greetings stored.  

 

 

 

 

 

 

 

 

 

 

 

 

 

To upload a voicemail greeting, it must be in .wav format. Choose the greeting und click on this icon      

to choose the file which you want to upload. 

By clicking on the Trashcan Icon        uploaded voicemail greetings are deleted. 

Active 

Greeting 

Active 

Greeting 

Active 

Greeting 

Greeting 

Stored 

Selection Menu Greetings 

Activate Greeting 

Upload Greeting 

Delete Greeting 
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Team 
Teams are configured on the c2d5 server. Single c2d5 users can be added to several teams. For each 

team there is an own tab.  

Overview 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Team Note 
In the Team Note line you can write a short note for your team. This info appears instead of the 

online state. Entering is released with the enter button. To delete the note click on the cross      .     

Example: 

 

 

 

 

 

Team Tab 

Team Note Undock 

Window 

Team 

Options 

Team Tabs 

Team List 

Online State 

Chapter: Main 

Window ->Status 

Indicator 

Team Note 

Delete Team Note 
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Undock Team Window 
Clicking on this icon         undocks the team window. Instead as a tab in the Main Window the Team 

Window is now in a separate window.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Next to the window options you already have in the Main Window, the Team Window can be 

docked to the upper top of the desktop by clicking on this icon. 

If the Team Window is closed         it will be a tab in the Main Window again. 

The complete view can be reset to default. To do this click with the right mouse button on the c2d5 

Icon          in the taskbar to reach the Taskbar Menu and choose Reset view.  

Also see chapter Taskbar Menu.  

 

 

 

 

 

 

 

 

                            Undocked Team Window 

 Reset view 
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Team Options 
 

 

 

 

 

 

 

Monitoring 
To monitor calls, click on this icon       at the team member. If the monitoring is active the icon looks 

like this:  

 

 

 

 

 

 

 

 

If the monitored user gets a call a popup appears on which the call can be answered: 

 

 

 

 

 

 

 

 

To activate/deactivate a beep sound, click on the Bell Icon:        /       (off/on) 

To set the time after when the popup should appear, click on the slider,                  and hold it to drag. 

The time can be adjusted between 0 and 30s. 

Activate/Deactivate 

Monitoring 

Team Chat 

Activate/Deactivate beep on incoming 

call on monitored team user 

Time Monitoring  

View 

Sorting 

Activate/Deactivate 

Monitoring 

Incoming Call 

Answer Call 

Ignore 

Monitored User 
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Call Forward 
By clicking with the right mouse button on a team member or yourself, you can set a call forward. 

Move the mouse cursor over the arrow to see the selection menu and choose the needed call 

forward option. Also see chapter Tabs-> Home Tab-> Call Forward.     

 

 

 

 

 

 

 

 

There are following call forward options: 

 

                            Calls are not forwarded. 

 

                                        Calls are forwarded immediately. 

 

                              Calls will be forwarded when the line is busy. 

 

                                     Calls will be forwarded after a certain time. The time is configured on the 

telephone system. 

 

                                      Calls will be forwarded after a certain time and when the line is busy.       

 

After choosing an option, a window opens. Enter a number or search term and choose where calls 

are forwarded to by clicking on the entry. 

 

 

 

 

  

 

Selection Menu 

Search Line 
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Selection Menu 

Monitoring 

Team View 
To display the team there are various options: 

 

 

 

 

 

 

Examples: 

 

 

 

 

 

 

  

 

 

  

  

 

 

 

 

 

By double-clicking a team member or clicking on the Line Status Icon you start a call to this person. 

The Line Status can have following appearance:  

            free            busy               Out of Service               Call Forwarding active 

          Call Center Agent free              Call Center Agent busy                     CC Agent Private Call 

 

Appointments can be seen when the mouse cursor is moved over the Calendar Icon. 

Name 

Team Note 

Next Appointment 

Telephone Number 

and Status 

Status of the Line 

Chat 

Profile Picture 

Online State 
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Phone Number 

Name 

 Online State 

Line Status 

Monitoring 

Appointments 

Online State 
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Selection Menu 

Sorting 
These sorting how the team members are sequenced in the view are available:  

 

 

 

 

 

 

 

                   Sorting names in alphabetical order. 

 

                            Sorting phone number numerically. 

 

                                  Sorting by online status and name. Team members which are offline are shown in 

the bottom of the list. The names are sorted in alphabetical order in each online state. 

 

                                           Sorting by online status and phone number. Team members which are offline 

are shown in the bottom of the list. The phone numbers are sorted in numerical order in each online 

state. 

 

                              The list can be sorted individually by drag & drop. Click on the team member and 

hold the mouse button to move the entry on a position you wish. 
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Chat 

Overview 
 

 

 

 

 

 

 

Clicking on the Chat Tab Icon opens the last chat. 

In the Chat List          are all existing chats. 

 

 

 

 

 

 

 

Clicking on the respective chat opens it.  

 

 

 

 

 

 

 

 

Own messages that the addressed person has received have a green checkmark.        If the message is 

read, two green checkmarks         can be seen under the message. To be registered as read, the 

addressed person must move with the mouse cursor over the message or switch to the 

corresponding chat window. 

 

Chat Tab 

Show     

Chat List 

Own Message 

Received Message 

Undock Window 

Blend out 

Chat List 

Delete Chat History Call 

E-Mail 

Enter Message Choose 

Emoji 
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To start a chat, click on the Chat Icon         at c2d5 users in the Contacts Tab or the Team Tab.  

Example Contacts Tab: 

 

 

 

 

 

 

Team Chat 
Each team has an own team chat.  

To open the Team Chat window, click on the Chat Icon        in the corresponding Team Tab. 

 

 

 

 

 

 

Or click on the Team Chat in the Chat List: 

 

 

 

 

 

 

 

 

 

 

 

 

Example 

Team Chat 

Team Chat 

Participants 

Delete     

Chat History 

Enter Message Select 

Emoji 

Chat 

Online State 

Team Chat 

Team Tab 
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Undock Chat Window 
Clicking on this icon         undocks the chat window. Instead as a tab in the Main Window the Chat 

Window is now in a separate window  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Next to the window options you already have in the Main Window, the Chat Window can be docked 

to the upper top of the desktop by clicking on this icon. 

If the Chat Window is closed        it will be a tab in the Main Window again. 

The complete view can be reset to default. To do this click with the right mouse button on the c2d5 

Icon          in the taskbar to reach the Taskbar Menu and choose Reset view.  

Also see chapter Taskbar Menu.  

 

 

 

 

 

 

 

Undocked Chat Window 

 Reset view 
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Outbound 
This tab is configurable on the c2d5 server for call centers. 

Overview 
 

 

 

 

 

Outbound List 
Call center calls, which are hung up while ringing or in the waiting queue, are listed here.  

Also, there is the option to import contact lists to be called. The assignment of users to different lists 

can be done on the c2d5 server. Contact lists can come from ODBC databases, CCD of the PBX or 

from the IVR of the sys-Voice Gateway. If an ODBC database is used, predefined data can be written 

back to the database after hanging up the call. The results will be monthly summarized and saved as 

a CSV-file on the c2d5 server. 

The next call can be started automatically or by hand.  

  

 

 

 

 

 

 

 

 

Automatic Outbound Call 
Clicking on this icon,       starts the automatic outbound call. 

A countdown of 15s will start before the editing window opens. 

 

 

When the editing window is closed the countdown starts again and a new editing window is opened. 

To stop the automatic outbound calls, click on the icon again:  

 

Outbound Tab 

Start automatic outbound call 

Amount of outbound calls 

Start 

processing 

Start automatic outbound call 
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Edit an Outbound Call  
Example of an outbound call: 

 

 

 

 

 

 

 

 

 

 

 

  

To start the call, click on the Telephone Receiver Icon:  

The processing can have these types:  

 

 

 

 

 

To finish editing the info field must be filled. To end the processing press the save button. 

 

 

 

 

 

While editing an outbound call the other group members are informed about the processing state: 

 

 

 

Caller Status info 

Start call 

State of the 

Editing 

Selection Menu 
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CCD Dashboards 
To see clear information and statistics about pilots and processing groups, dashboards are available 

for call centers. Dashboards can be configured on the cd25 server. Each dashboard has its own tab.  

Overview 
 

 

 

 

 

 

 

 

Undock CCD Dashboards Window 
Clicking on this icon        undocks the CCD Dashboards Window. Instead of the CCD Dashboards Tab 

in the Main Window the CCD Dashboards Window is in a separate window.  

 

 

Next to the window options you already have in the Main Window, the CCD Dashboards Window 

can be docked to the upper top of the desktop by clicking on this icon. 

If the CCD Dashboards Window is closed        it will be a tab in the Main Window again. 

CCD Dashboards 

Undock 

Window 

Tab Change after Time 

Dashboard 

Tab 

Adjust 

View 



 

 

69 

The complete view can be reset to default. To do this click with the right mouse button on the c2d5 

Icon          in the taskbar to reach the Taskbar Menu and choose Reset view.  

Also see chapter Taskbar Menu.  

 

 

 

 

 

 

 

 

 

Element Pilot  
Here you see general current information about conversations. The data Efficiency and Service Level 

are taken over from the CCS. 

 

 

 

 

 

 

Service Light 
The Service Light shows the current state of the dashboard elements. If, for example, agents are 

online and free the Service Light is green. 

 

 

 

 

Current Calls/Conversations 

  Service Light 

 Reset view 
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Element Pilot (Daily Stats)  
Detailed information about calls and conversations are displayed here. If the mouse cursor is moved 

over a bar, details to the respective hour is displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Element Queue 
Current statistics to waiting conversations are displayed in this overview.  

 

 

 

 

 

 

 

 

Info From Chosen Hour 
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Element Processing Group (Agents) 
Current information about agents is displayed here.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tab Change after Time 
If there are several dashboards, you can set on the slider                    after which time the view 

changes to an other Dashboard Tab. (0-60 seconds). To move the slider, click and hold to drag. 

 

 

In Conversation 

Wrap Up 

Pause 

Free 
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Adjust Dashboard View 
Clicking on the Gear Icon           opens the view settings. The sorting and size of the dashboard 

elements and the display of the instruments can be set here. 

 

 

           

        Move Element to the Left            Enlarge Element Horizontally 

        Move Element to the Right           Shrink Element Horizontally 

        Move Element Up         Enlarge Element Vertically 

        Move Element Down        Shrink Element Vertically 

 

The presentation of the instruments can be changed to following: 

 

 

 

 

 

 

Examples:    

 

                                                                    

 

 

 

 

 

                                    

 

                                                                      

 

 

Selection Menu 
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Internet Phonebook 
A connection to ©DasTelefonbuch can be set on the c2d5 server, so this tab is available. Then access 

to an actual telephone number database is enabled.  

Overview 
 

 

 

 

 

 

 

 

To search enter name, telephone number, city, postcode and/or phone prefix in Search Fields and 

press return. 

 

Browser 
Websites like a ticket system or time management tool can be integrated here. On the c2d5 server 

this tab can be configured.   

Overview 
 

 

 

 

 

 

 

 

 

 

 

 

Tab Internet Phonebook 

Search 

Fields 

Website Tabs 

Browser Tab 

Website 
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Taskbar Menu 
To reach the Taskbar Menu click with the right mouse button on the c2d5 Icon on the right in the 

taskbar:  

 

Overview 
 

 

 

 

 

 

 

 

               The user will be logged out. See also chapter Logout. 

 

                                  The Settings menu will be opened. See also chapter Settings/Configuration. 

 

                               The view settings of the client will be reset to the origin settings. This is helpful 

when you can´t find the c2d5 window anymore, for example when using a second monitor which is 

not available after a new login. 

 

                          This is a link to the systel knowledge base website.  

 

                              This is a link to the systel bug report website, to report errors of the software. We 

also appreciate suggestions to new features. 

 

                    c2d5 will be quit without a security request. 

 

Taskbar Info 
New missed calls, outbound list entries, voice mails on the answering machine or chat messages are 

shown with a blinking number in the Taskbar Icon of the client: 

  

 

 

Info Software Version 
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Busylight 
c2d5 automatically recognizes a connected Busylight by USB. This light shows your colleagues your 
communication status visually. Depending on the status it changes the color of the LED.  

Following color standard is used: 

blinking green = incoming call 
red = active call 
blinking blue = new message 

Busylights can be bought at systel. 

 

Door Camera 
c2d5 supports the usage of door cameras. Pictures of the door camera can be assigned to users with 

the c2d5 manager. Then the door camera is an extra tab in the Browser Tab. 

If the doorbell rings, the door cam picture appears in a separate popup window and the caller popup 

appears. By accepting the call, a conversation to the door intercom is made. By clicking on the Door 

Opening Icon in the door cam picture the door can be opened. Also, by the predefined DTMF Tones 

the door can be opened. See chapter Call, Answer, and Hang up-> DTMF Dialing 

 

 

 

Open Door 


